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SONAR 2015  

“Jamaica Plain” Update 
 

This month’s update introduces a ground-

breaking new addition to SONAR’s Universal 

Routing Technology: Patch Points. Now you 

can create, name, and delete “Patch Points” 

for bus and track I/O, and interconnect them 

for functions like track-to-track recording, bus-to-track recording, submixing, and much more. 

Of course that’s not all—there are major performance optimizations that affect all SONAR users 

(especially those who use lots of virtual instruments), upsample on playback, and more. So we 

won’t keep you—go make some great music. – Bill Jackson and the Cakewalk Team 

 

 

Patch Points: This fulfills the other half of the promise of synth recording—send 

just about anything to anywhere, and record it all in a track. Whether you want to 

patch a track output to a track input, a bus or send output to a track, or record 

effects in real time, Patch Points can do all of these functions—and much more. 

 

Aux Track: The Aux Track is a new track type that complements Patch Points. You 

can specify an Aux Track as a Patch Point, then feed a combination of multiple 

tracks, buses, or sends into it. The Aux Track is an ideal destination for summing, 

submixing, organizing, and controlling multiple tracks. 

 

Patch Point and Aux Track Applications: Now that you have this functionality, 

what are you going to do with it? This section covers several ways to use Patch 

Points and Aux Tracks, from multiband processing, to parallel processing, to ways 

to create different types of workflows. 

 

Start Screen Enhancements: Performance has been greatly improved; the Start 

Screen now appears immediately after SONAR loads or you call it up from the File 

menu. The Start Screen also appears more selectively, and various language 

incompatibility issues have been addressed.  

 

Upsample on Playback: As an extension to SONAR’s innovative upsampling 

technology, Upsample on Playback allows hearing upsampled plug-ins in real time 

during playback. Preview, compare, and process your audio with this new addition 

to SONAR’s audio engine.  
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Performance Optimizations: Load times, virtual instrument streaming, transport 

play/stop speed, VST scanning, pre-roll code, and CPU power savings—SONAR’s 

code has been stripped down and rebuilt for greater speed and smoother 

operation in several crucial areas. 

 

Workflow Enhancements and Fixes: In addition to the Start Screen 

enhancements, this update offers multiple fixes including another Staff View fix, 

VX-64/PX-64/Channel Tools updates that solve the audio pop issues that could 

sometimes occur, and fixes for a variety of intermittent issues. 

 

Review | Electronic Dance Music Grooves: Want to get into EDM, or fill SONAR’s 

step sequencer with some cool grooves? This book covers the process of creating 

beats with drums, gives plenty of examples, and includes a download code for 

hundreds of drum samples and MIDI files.  

 

Anatomy of a SONAR Project—Replacing the Placeholder: Cakewalk’s Jimmy 

Landry recently finished working on an award-winning indie movie. How he used 

SONAR—as well as the process of how to create something that keeps the director 

and producer happy—makes for a very interesting story. 

 

BlogBeat: A roundup of a few of the Cakewalk Blog’s “greatest hits.” Find out the 

“wrong” way to use the Drum Replacer, master the art of transient shaping, get 

the scoop on what Windows 10 means to SONAR, arrange your song ideas in the 

Matrix View, and find out what happens to signals once they’re inside of SONAR. 
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How to Download the Jamaica Plain Update 
 

Open the Cakewalk Command Center. If you don’t have the latest installer 

(CakewalkCommandCenterSetup1.1.2.2.exe), please download it from the Cakewalk Command 

Center home page.  

 

To download the Jamaica Plain core update itself, download from the core SONAR Artist, 

Professional, or Platinum category.  

 

Professional and Platinum users should update the Engineering Suite (the LED will be yellow) to 

update Channel Tools. 

 

Platinum users should also update the Boutique Suite (the LED will be yellow) to update the VX-

64 and PX-64. 

  

https://www.cakewalk.com/Command-Center
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Patch Points   
Professional, Platinum 
 

Cakewalk has been quietly developing a Universal Routing Technology that gives tremendous 

flexibility when routing signals within SONAR. One of the first examples was the FX Chain, which 

provided a “container” for routing effect inputs and outputs together, and had the intelligence 

to disconnect controls if the effects being controlled were removed. The ProChannel and FX 

Racks are a basic example of taking the “insert jacks” on mixers to a more flexible level by 

providing two ways of inserting effects, where one block could be pre or post compared to the 

other. 

 

Synth recording took the concept another step further by allowing real-time recording of synth 

outputs, but now Patch Points and Aux Tracks introduce a mind-boggling level of flexibility: you 

can feed tracks (audio or instrument) into tracks, buses into tracks, sends into tracks, or even 

(get ready!) tracks, sends, and buses into the same track—and much more. It’s even possible to 

do something like feed track outputs and bus outputs into an Aux Track, when can then feed 

with other Aux Tracks and a Send into a different track. This may sound complicated enough to 

make your head explode, but it’s all implemented in a smart, intuitive way that not only adds 

no clutter to the Track or Console view, but even cleans up unused patch points if the routing 

changes. 

 

Please note: Projects that contain Patch Points and Aux Tracks cannot be opened in SONAR 

versions prior to SONAR Jamaica Plain (Update 9). If you need to open a project in an earlier 

version, first back up the project, unassign any patch points, then re-save the project. 

 

For detailed Patch Points information, see the New Features section in SONAR’s online Help. 

 

 

CREATING, CHOOSING, AND ASSIGNING PATCH POINTS 

 

When you open a track input or output picker, or a send or bus output picker, you’ll see the 

option “New Patch Point.” Select this to create a Patch Point. This is also how you pick an 

existing Patch Point. Creating a Patch Point assigns a number that increments with each new 

Patch Point, but you can rename this (as described later). If a track’s input is a Patch Point, the 

track icon changes to a distinctive “Patch Point in use” icon. 

 

 



6 | P a g e  
 

 

Example 1: You want to patch Track 1’s output to Track 2’s input. Select “New Patch Point” for 

Track 1’s output to create Patch Point 1. Now for Track 2’s input, select Patch Point 1. Track 1’s 

output now patches to Track 2’s input. 

 

Example 2: You want to patch Track 1’s output and the output from a send in Track 6 to Tracks 

2, 3, and 11. Follow the example above, but additionally, choose Patch Point 1 for the inputs to 

Tracks 3 and 11, and re-assign the send in Track 6 to Patch Point 1.  

 

You can create new Patch Points from any input or output picker. Patch Points are not 

necessarily associated with the track or bus where they were created; like an audio interface’s 

physical input and output, any track can pick any available Patch Point as an input, and any 

track, bus, or send can pick any available Patch Point as an output. The only significant 

restriction is that SONAR will not allow creating a feedback loop. 

 

PATCH POINT SIGNAL FLOW CHART 

 

Here’s a graphical representation of how a representative Patch Point connection might work. 

 

 
On the left, output sources (tracks, buses, and sends) all terminate in the same Patch Point. On 

the right, the Patch Point output can connect to audio and Aux Track inputs. All routing and 

submixing is handled transparently in the background. Multiple outputs can connect to a single 

input, and a single output can connect to multiple inputs. 

 

RENAMING PATCH POINTS 

 

To rename a Patch Point, follow the input picker’s Patch Point’s selection menu and choose 

Rename patch point. The Patch Point does not need to be the selected patch point in order to 

be renamed. Patch Points cannot be renamed from the output picker. 
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PATCH POINT HANDLING 

 

 When no input or output connects to a Patch Point, it’s considered unused and SONAR 

automatically recycles it dynamically to make your projects less complicated. 

 Deleting a track will not remove associated Patch Points, so that undo and redo can 

work. However, loading a project removes any unused patch points. 

 SONAR prevents assigning Patch Points that could cause a feedback loop. 

 Assigning a Patch Point to a track input automatically enables Input Echo. Selecting 

“None” for the input turns off Input Echo. 

 Disconnecting all inputs and outputs to a Patch Point hides the Patch Point to prevent 

clutter, but unused Patch Points are not deleted until you save, close, and re-open the 

project. That way, they remain available for undo/redo. 

 Patch Point and Aux Track creation can be Quick Grouped. 
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Aux Track   
Professional, Platinum 
 

The Aux Track is a new track type that’s a great complement to Patch Points. It’s simply an 

audio track with its input assigned to a Patch Point, so you can specify the Aux Track as a Patch 

Point, then feed multiple tracks, buses, or combinations of tracks or buses into it. This makes 

the Aux Track an ideal destination for summing, submixing, organizing, and controlling multiple 

tracks. You can also think of an Aux Track as a bus that can live with other tracks and be 

included in a Track Folder. You add an Aux Track just like you’d add a Patch Point—by selecting 

via a track or bus’s output menu. 

 

  
 

The Aux Track now appears like a Patch Point in output menus. 

 

 



9 | P a g e  
 

 

 

 

AUX TRACK TIPS  

 

 If you rename the Aux Track, the name of the output of any track feeding into it updates 

automatically to reflect the change. 

 An Aux Track can go to any available destination including another Aux Track, a 

sidechain input, etc. 

 The Aux Track input can be an output generated within SONAR, like a virtual instrument 

output or another Aux Track. You can also create a new Patch Point from the Aux Track’s 

input field. 

 Aux Tracks are audio tracks, with the only difference being that they have a Patch Point 

input. As a result they behave like other tracks with respect to automation, inserting 

effects, etc. 

 To monitor what’s going into an Aux Track, you need to enable Input Echo. 

 To record what’s going into the Aux Track, enable its Record button and initiate 

recording. 
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Patch Point and Aux Track Applications   
Professional, Platinum 

 

Here are some representative applications for using Patch Points and Aux Tracks. There are 

often several ways to accomplish the same functionality, so use whichever is most comfortable. 

For example, if you already have existing tracks that you want to connect to Patch Points, it’s 

probably easier to assign their inputs to Patch Points than create new Aux Tracks. However, if 

you’re setting up a new recording scenario, it will probably be easiest to create an Aux Track as 

that will create both a track and a Patch Point assignment. 

 

APPLICATION #1: RECORDING THE METRONOME TO A TRACK 

 

Note: If your project already contains a Metronome bus, skip to step 7. 

 

1. Choose Insert > Stereo Bus to create a new bus for the audio metronome. 

2. Rename the new bus to Metronome. 

3. Choose Edit > Preferences > Project - Metronome. 

4. Select the Recording check box and clear the Playback check box (you will hear the 

recorded metronome instead during playback). 

5. Select “Use Audio Metronome.” 

6. Click the Output drop-down menu and select the bus named Metronome, then click OK 

to close the Preferences dialog box. 

7. Click the Metronome bus’s Output control and select New Aux Track on the pop-up 

menu. 

8. Arm the Aux Track for recording. 

9. Begin recording. 

 

APPLICATION #2: TRACK/BUS/SEND-TO-TRACK RECORDING WITH PATCH POINTS 

 

1. Assign the source track, bus, or send output to a Patch Point.  

2. Assign the destination track input to the same Patch  

Point.  

3. Record-enable the destination track. Input Echo can be on or off. 

4. Initiate recording. 

 

APPLICATION #3: TRACK/BUS/SEND-TO-TRACK RECORDING WITH AUX TRACK 

 

1. Assign the source track, bus, or send output to An Aux Track.  

2. Record-enable the Aux Track. Input Echo can be on or off. 

3. Initiate recording. 
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APPLICATION #4: MULTIPLE TRACKS/BUSES/SENDS TO SINGLE TRACK RECORDING 

 

1. Assign the source track/bus/sends outputs to an Aux Track. You can use any 

combination of tracks, buses, and sends. Note: You may need to adjust output levels 

when combining multiple outputs to avoid overloading the Aux Track. 

2. Record-enable the Aux Track. Input Echo can be on or off. 

3. Initiate recording. 

 

APPLICATION #5: MULTIBAND PROCESSING 

 

There are many possible applications; here’s a typical use involving multiband distortion.  

 

 
 

A guitar feeds four tracks, each with a Sonitus:fx Multiband compressor. Each Multiband 

compressor has a different band soloed to divide the guitar into four frequency bands, with 

each band distorted via the TH2 amp sim (the reason for distorting each band individually is 

lower intermodulation distortion and a “cleaner” distortion sound). The outputs then terminate 

in an Aux Track, which mixes all four tracks without having to set up sends. Furthermore, all the 

tracks can be processed simultaneously using the Aux Track’s FX Rack, and placed within a Track 

Folder to tidy up the Track View layout. 
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APPLICATION #6: BUSLESS PARALLEL PROCESSING 

 

Parallel processing usually involves either copying a track or using a bus. The Aux Track and 

Patch Point functionality simplifies this process, and allows inclusion within a Track folder.  

 

The following example shows applying parallel compression to percussion. 

 

 
 

The main Percussion track output terminates in the Master bus, but it also includes a Send. The 

send patches to an Aux Track, which includes the parallel processor (Blue Tubes FA770). The 

Aux Track also terminates in the Master bus, thus providing the parallel path. 

 

ADDITIONAL APPLICATIONS 

 

 You can work exclusively in Track View, and have folders of tracks with their Aux Tracks 

adjacent to them. This workflow provides an alternative to routing tracks to buses. 

 Treat the Aux Track as a subgroup, and control multiple audio track volumes with one 

fader. 

 Control surfaces that don’t support buses can instead control Aux Tracks. 

 Record only a track’s effects send to a separate track. For example, you can record a 

delay effect to a separate track, and shift the timing as desired. 

 Capture real-time performances with guitar effects, including amp sims. 

 Record time-based effects in real time. 

 Record plug-in parameter changes that are not automatable. 
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Start Screen Enhancements   
Artist, Professional, Platinum 

 

 
 

The Start Screen has some major improvements that will get you off to a better…start. 

 

 The Start Screen now appears immediately after SONAR has loaded, or you select Start 

Screen from the File menu.  

 If you close a project, the Start Screen does not re-appear automatically (although you 

can always select it from the File Menu). 

 Several language incompatibilities have been addressed. 

 Clicking on the File menu closes the Start Screen if present. 

 The Default Template now moves to the top of the list. 
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Upsample on Playback    
Artist, Professional, Platinum 

 

Some plug-ins and virtual instruments sound better when recording at sample rates higher than 

44.1/48 kHz because high audio frequencies can interfere with lower clock frequencies, which 

causes foldover distortion. This adds a “wooliness” at lower frequencies, and can also 

compromise high-frequency response. Plug-ins that include internal oversampling do not have 

this problem, but not all plug-ins—particularly older ones—use oversampling. 

 

The Foxboro update introduced Upsample on Render, which provides the benefits of using 

higher sample rate processing even in 44.1 kHz or 48 kHz projects by internally 2X up-sampling 

plug-ins of your choice, rendering them as audio, then down-sampling the rendered audio back 

down to the original sample rate. While it may seem counter-intuitive that the audio quality 

from rendering at 96 kHz is preserved at lower sample rates, the lower sample rates have no 

problem reproducing signals in the audio range, and by rendering at 96 kHz, the problematic 

frequencies no longer exist. 

 

The Jamaica Plain update now offers Upsample on Playback, so you can preview and compare 

the difference in real time. To enable either Upsampling on Render or Upsampling on Playback 

on a per-plug-in basis, click the FX button to the left of the instrument name in the virtual 

instrument interface.  

 

 
 

To turn Upsampling on or off globally for plug-ins that have upsampling enabled, use the 2X 

button in the Control Bar’s Mix module. 
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Performance and Engine Optimizations   
Artist, Professional, Platinum 
 

In addition to implementing new features, we continue to probe existing elements within 

SONAR for potential improvements. The Jamaica Plain update is the culmination of work that’s 

been going on “behind the scenes” to make the latest version of SONAR the fastest and 

smoothest yet.  

 

DYNAMIC SILENT SYNTH OUTPUT CPU SAVER 

 

SONAR detects silence on VST2 and VST3 synth outputs, and dynamically activates the output 

for input monitoring/mixing/recording only when a synth output is not silent. For projects or 

templates containing hundreds of synth tracks, the CPU savings can be significant. (Note that 

although VST3 supports turning off plug-ins when silent, hardly any instruments implement 

this. Fortunately, SONAR’s built-in output CPU saver provides the same results.) 

 

DYNAMIC ARM DURING PLAYBACK/RECORD 

 

Dynamic Arm for inputs now performs record pre-roll only for inputs actually present in the 

project, resulting in more responsive transport startup and stop when pressing play (especially 

for projects with synth inputs). This option also skips processing for archived tracks, saving 

additional CPU consumption. 

 

EXCLUDE SYNTH INPUTS FROM ALLOW ARM CHANGES  

 

 
 

In Preferences > Project > Record, checking the boxes under “Allow Arm Changes” (they default 

to checked) improves transport performance on start and stop with large projects containing 
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hundreds of synth tracks. When checked, you can arm tracks only when the transport is 

stopped. This avoids record pre-roll overhead caused by needing to pre-create record files for 

synth inputs. 

 

SYNTH STREAMING CPU MULTIPROCESSING 

 

For maximum efficiency with projects containing many virtual instrument tracks, the synth 

streaming code streamlines multiprocessing to reduce CPU load on synth track playback. 

 

GENERAL PRE-ROLL IMPROVEMENTS 

 

The pre-roll code improves transport startup by identifying and ignoring unneeded startup 

tasks. 

 

IMPROVED PROJECT LOAD SPEED  

 

The project load code now prevents unnecessary engine start/stop transitions, so loading 

projects containing hundreds of tracks is now orders of magnitude faster.  

 

VST SCANNING OPTIMIZATIONS AND ENHANCEMENTS 

 

 Scanning is faster for “shell” plug-ins that contain many sub plug-ins (e.g., Waves). 

 With plug-in suites where the number of available VST2 or VST3 plug-ins can change 

dynamically, SONAR automatically removes de-activated plug-ins from the inventory 

and adds them back if re-activated.  

 It’s no longer necessary to reset the VST inventory to see plug-ins that previously were 

not scanned successfully.  

 Unauthorized plug-ins no longer appear in SONAR’s user interface. 

 

 

  



17 | P a g e  
 

Fixes and Workflow Enhancements 
Artist, Professional, Platinum 

 

Fixed issues where: 

 

 MIDI inputs did not work correctly when Quick Grouped  

 Dragging clips with a large snap offset would not work properly 

 Sends on Instrument tracks would not respect follow track pan 

 Focus would switch to the Track View from Event List when using the "Kind of Event" 

dialog 

 Now time would not adjust on the time line when clicked more than once   

 Multiple LP-64 plug-ins could cause playback and rendering issues under some 

conditions 

 MIDI record confidence recording preview would not work under certain conditions 

 Event List had display problems with 25 characters or more 

 Shelf graphics were reversed in EQ 

 Pasting a composite clip to a new track could cause a hang 

 Fit MIDI Content in PRV and inline PRV was inconsistent 

 3rd party ProChannel plug-ins would not display correctly when tracks were cloned 

 Drag and drop to the Browser could create a problem with a folder created in Windows 

 VX-64 Vocal Strip plug-in (Boutique Suite) could cause audio output issues in projects 

 Quickly freezing multiple tracks with Drum Replacer could crash 

 Export to DSD could crash on AMD systems 

 Channel Tools plug-in (Engineering Suite) could cause audio output problems 

 Track and folder names didn’t work correctly with synth replace 

 Sonar font sizes would shrink when adding TruePianos VSTi 

 Opening projects without saving was not populating the Start Screen correctly  

 Start screen was not displaying some characters correctly, causing projects not to open 

upon sign-on in Windows 7 OS 

 Staff View had snapping problems when adding notes  

 Launching projects from the desktop was not enabling the audio engine 

 Start screen behavior was not optimized when accessing menus 

 Delete key and right-click smart tool delete were not working in PRV Drum pane view 

 Templates were not saving audio correctly 

 Recording synths from mono inputs was not working 

 Browser did not support .png graphics format 

 Linked Melodyne clips were not rendering properly, thus causing silence 

 SONAR could crash when deleting a REX loop while open in Loop Construction view 

 Eiosis plug-ins would not scan properly after update 
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 Certain files and templates could take a long time to load 

 Clicking on some controls caused unnecessarily “dirty” documents 

 Control Bar Performance module was not updating properly when disabling 

Multiprocessing Engine 

 Horizontal mouse scrolling didn’t work with mouse hardware that supported horizontal 

mouse scrolling  
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Review: Electronic Dance Music Grooves 
Hal Leonard Books 

Softcover, 263 pages, $17.48 

 

By Craig Anderton 

 

Okay, so what’s a book written by Josh Bess, an Ableton 

Certified Trainer, doing in here? Simple: the book is just 

as applicable to SONAR—and maybe even more so given 

SONAR’s inclusion of a Step Sequencer along with the 

MIDI Piano Roll View. 

 

You can skip the first chapter, which describes Live 

basics. The second has useful concepts for beginners 

that translate to SONAR, but the meat of the book—170 

pages—is Chapter 3, which shows screen shots for 

grooves. Musical styles include house, techno, 

breakbeat (e.g., hip-hip, drum ‘n’ bass), and world (e.g., 

dance hall), along with several sub-genres for each. 

 

Although beats are shown using Live’s Piano Roll View, 

it’s easy to translate to SONAR’s PRV or Step Sequencer. Each pattern also includes info about 

some of the techniques used in the pattern, as well as occasional tips. 

 

Chapter 4 is 14 pages about drum fills and 

transitions, again using screen shots for 

examples, while Chapter 5 covers Groove, 

Swing, and Feel. This takes only slightly more 

effort to translate into SONAR’s equivalents. 

Chapter 6 has 22 pages of how to build drum 

kits in Live from one-shots, and Chapter 7 is a 

one-page summary.  

 

The book also includes a code for downloading 

a variety of media. For SONAR users, the items 

of greatest interest are the 292 drum samples 

(mostly WAV, some AIF, both of which are easy 

to load into Session Drummer to create your 

own kits), along with the 642 MIDI files for 

grooves and the 19 MIDI files for fills.  
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For under $20, some might consider the samples and MIDI files alone worth the price, and you 

can take advantage of what’s presented in the book without even having to read most of it. 

However, the explanations for the rationale behind programming the beats provide a helpful 

background for those who want to go beyond just importing something and using it “as is.” 

Bess’s background as a percussionist certainly helps, as it gives a perspective beyond just “put 

these notes on these beats.” 

 

Overall, for those getting into dance music, this book lets you hit the ground running with 

actual files you can use in a wide cross-section of styles. I could also see this information as 

being useful for those doing soundtracks if they’re not as familiar with certain styles, yet need 

to create music using, for example, Dance Hall or Dubstep beats. 
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Anatomy of a SONAR Project: Replacing the 

Placeholder 
 

By Jimmy Landry 

 
Sometimes I take on a project outside of Cakewalk, and I 
love that those projects let me put our current SONAR 
Platinum “Rolling Update” to the test in the field. Recently, 
the LA-based production company Coffee Ring 
Entertainment asked me to write, produce and deliver three 
tracks for their new movie, For Blood. This article describes 
highlights of the process involved in writing and producing 
one of those tracks for a specific scene in the film. 
 
My first question to the director was, “Do you already have 
placeholder music in the rough cut?” When producers and 
directors have placeholder music they like already set into the cut, it speeds up and simplifies 
writing and producing the music. Fortunately the answer was “yes,” so all I needed to do was 
replicate what they liked about their placeholder tracks using the array of instruments and 
plug-ins in my home project studio rig. 
 

A primary objective in writing music for film is to forget 
about yourself and your own emotional agenda. And 
oddly enough, for me at least, this notion really speeds up 
the workflow because you are writing/producing for 
someone else’s purpose other than your own thoughts. 
Adamantly keeping this in mind throughout the 
writing/producing process helps to stay focused on what 
the client wants. For this song, it’s exactly what I had to 
do because the producers had a Tarantino-ish type track 
set into the scene, and my innate production style tends 
to lean more towards big, clean commercial pop rock. 
Luckily, I could go to YouTube and analyze suitable styles 
of music but even luckier for me, SONAR’s Addictive 
Drums and TH2 plug-ins were  ideal for dialing in the kind 
of music that was needed. 

 
BUILDING THE FOUNDATION 
 
With any track, there has to be a start—it’s the song’s foundation upon which everything else 
builds. The start doesn’t have to be drums, but considering the style of music it was the most 
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logical place to begin. I usually start with my Track Templates of Addictive Drums (AD) where I 
have moderately complex routing architectures consisting of everything going to separate 
tracks, then to multiple buses with different layers of parallel compression and EQ. However, 
for this project I needed to dumb down the polish and sheen a bit, so for the first time I kept 
everything inside of AD.  
 
As a result, I found that AD has a very sweet FX processor which rivals just about anything I’ve 
conjured up outside 
of its own element. 
After browsing 
through a lot of kits 
(for the record, I 
absolutely love this process) I ended up using the Black Oyster Kit’s “Thin and Smacky” preset. 
From this foundation, I began to audition different MIDI patterns from the program’s internal 
library. This library is a huge feature, as the stock MIDI loops are so good that I end up having to 

modify them only after I get the 
right feel for a song. I’ll usually 
set up the song completely with 
loops, finish the writing, and 
then return to MIDI to make 
adjustments for more variation 
in the patterns/dynamics.  
 
I ended up using different 
patterns from the “Straight 
Beat” library, and then added 
my own tom hits using my 
controller. This process of 

writing drum parts really went hand-in-hand with the writing of the song― what I love about 
AD is that it becomes a writing partner for inspiration (and better yet, it doesn’t need to go for 
smoke breaks). 
 
After constructing the drums, I focused on 
finishing all the writing of the song itself. It’s 
easy to move drum parts around with the MIDI 
clips in SONAR’s Track View, so coming up with 
new parts is relatively simple and creative. At 
this point in a project, I’m more concerned 
about getting great lyrics and melody rather 
than the tones of the instruments. However, 
this part of the creation process is the most 
grueling because everything needs to revolve around the lyrics, melody and message—if that’s 
not on point, nothing else really matters. Once I felt confident that the writing was close to 90% 
done, I then focused in on the rest of the bed tracks. 
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MAKING THE BED 
 
Nine times out of 
ten I track guitars 
before bass, 
because I’m a big 
fan of bass 
players in the 
1970s where the 
bass line truly 
added to the 
overall delivery 
and direction of the song. By tracking bass after guitars, I can spruce up counterparts by laying 
in (sometimes slightly) unorthodox bass lines. For this song, I needed some bite but also wanted 
the foundation to stay organic, so I decided to track and double acoustic guitars (left and right) 
and then run those through a hefty dose of TH2. On one side I programmed the Lynch Box Plexi 
with a Randall cab, and on the other a Dark Face ’65 (US) through its stock 2x2 cab. After 
tweaking the mics and other parameters (mostly pulling out lows and adding mids), I had a 
really full-sounding guitar bed reminiscent of a hollow body electric. 
 
Next I laid in a guitar track, again using TH2, which landed on the snare hits. It’s a typical kind of 
comping technique where the guitar pulse lands on the snare and trails over with reverb. This 
track really gave the song the “certain feel” that the producer sought, even though he could not 
explain it in musical terms. Once these two parts were working together, it was time to 
consider adding the bass. 
 

Coming from a guitar world, bass 
tracking is a challenge because I 
have to stay disciplined and keep 
myself in check when trying to write 
compelling bass parts. Fortunately, 
this song was pretty straightforward 
and a simple bass part fit best. 
Another fortunate aspect of this 
song was its low-fi nature, because I 
had only my $200 Carlo Robelli bass 
at hand instead of the Gibson EB5 I 
usually borrow. So the bass was laid 
in going directly through a TASCAM 

UH-7000, and then processed with the Guitar Rig 5 Bass Pro head and Control Room Pro 
combo. I finished off the sound with minimal EQing from the ProChannel’s QuadCurve EQ to 
have the bass fit in with the AD drum bed, and was basically done and ready for vocals. 
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MAKING MYSELF SOUND LIKE SOMEONE WHO KNOWS HOW TO SING 
 
Vocals for me are always tricky. I’m a 
marginally decent singer who wasn’t 
gifted in the voice box department, so 
it’s taken me a long time to figure out 
different methods and techniques to 
make my voice sound good for different 
styles and genres of music. But that’s the 
fun part about doing music for film as a 
one-man show; experimentation 
sometimes translates into decent music.  
 
In this track I had the following vocal 
structure: Lead Comp, Lead Comp Dbl, 
and a Lead Low Octave. I ran the double 
and the low octave at about 40% 
compared to the lead vocal, and also 
compressed, and rolled off a lot of lows 
and highs to get it out of the lead’s way. 
I also used SONAR’s VocalSync on both 
performances to line them up to the lead which worked incredibly well—and fast! On all vocal 
tracks I always check for pitch trouble and then fix with SONAR’s built-in Melodyne. I love 
having this because my tracking goes a lot quicker knowing that I can doctor up my voice later 
to sound better (yep, I said it). 

 
The magic in this vocal track (if you can 
call it that) surprisingly came from one 
of my FX Chain Presets which includes 
the Z3Ta+ Classic synth being used for 
its effects section, combined with an 
echo from PSP. I absolutely love Z3TA+ 
for vocals. I’ve tried to analyze what it is 
that makes it work so well, and I just 
can’t put my finger on it other than that 
it just sounds darn great when mixing 
voices together. Each preset just brings 
vocals to a different place―and that’s 

what I love about it. For channel inserts and processing there’s a lot going on: From the top 
down I used the ProChannel’s CA-2A lightly, the QuadCurve EQ in Hybrid Mode, the BT Analog 
Track Box for some dirt, and then a moderately hefty dose of the N-Type Console Emulator. 
From here, multiple sends fed different effects. 
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Finally after everything was layered, the track tally ended up at only 24 tracks (it would have 
been 40 if I routed out from AD) and 14 buses―not too bad considering most of my projects 
usually land somewhere between 60 and 100 tracks. For this project, I tried to keep things 
simple while also keeping in mind what the producer of the film wanted. The mixing was 
straightforward and consisted primarily of SONAR’s QuadCurve EQ together with some vintage 
EQs from Universal Audio, PSP, and Nomad Factory. For effects I used Z3TA+, PSP Springbox, 
Breverb, Native Instruments Guitar Rig 5 (not for guitar), Overloud’s REmatrix Reverb, and some 

modulating plug-ins by Blue Tubes 
and iZotope. 
 
I like to leave mastering to the pros, 
but considering this was an indie film 
with an indie budget, I turned to 
SONAR’s LP-64 combo to get me in 
the ballpark on the master bus. Using 
Mix Recall comes in handy at this 
stage in mixing, because I like to try a 
lot of different mixes before sending 
out a final rendered reference. It’s 
also handy since I had to deliver both 
instrumental and a capella versions, 
as well as the master. 
 
 

The effort was worth it: The film’s Director and Producer 
loved the track. There were only a few requested changes, 
and the song replaced the placeholder. This was the first 
song out of three, so having the first one pass through 
confidently with all thumbs up made the rest of the gig 
pretty stress-free. The icing on the cake was getting a text 
from the director letting me know that the film had just won 
the Kumeyaay Eagle Award at the San Diego Film Festival. I 
don’t think I’ll get the eagle, but I’m sure I’ll be able to retire 
now considering the current state of the music 
industry…okay, maybe not. But at least I enjoyed the 
experience, and was able to put the SONAR Platinum 
Foxboro Release to the test before it hit the public. 
 
Listen to the music here 
 
“For Blood” movie home page 
 

  

https://soundcloud.com/audiostrike/out-for-blood
http://forbloodmovie.com/
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BlogBeat 
 

The Cakewalk blog is loaded with useful and interesting information, so don’t miss out! Here 

are some of the blog’s “greatest hits.” 

 

Do You Have Too Many Song Ideas? The Matrix View Can Help. If you thought 

the Matrix View was only about EDM production, you really need to read this 

article. Dan Gonzalez explains how to use the Matrix View as an arranging tool 

to throw all your licks, riffs, and ideas in one place to simplify life and get 

creative—there’s even a link to some free guitar loops to get you started. 

 

What Windows 10 Means for Music Creators. So…Windows 10 is a free update 

and if you have Windows 7 or 8, you don’t even need to do a clean install. But 

does it offer any significant advantages for musicians working with SONAR? 

Noel Borthwick, Cakewalk’s Chief Technical Officer, explains what you need to 

know if you want to move to Windows 10. 

 

Using Cakewalk Drum Replacer: The “Right” Way and the “Other” Way. Yes, 

the Cakewalk Drum Replacer works extremely well for its intended 

applications, but can also be abused and applied to scenarios for which it was 

never intended. Software abuser extraordinaire Joey Adams shares how he 

survived getting weird with drum replacement. 

 

The Art of Transient Shaping with the TS-64. Transient shaping is invaluable for 

all kinds of tracks other than drums, including bass and acoustic guitar. Craig 

Anderton explains the nuances of this powerful processor, including 

information on how to “smear” audio as well as sharpen it, and even how to 

customize the look.  

 

Know Your Signal Flow in SONAR. Exactly how does signal flow in SONAR? Why 

do buses have an added Pan control after the Trim control compared to 

tracks? Where do effects go in the flow, and is the ProChannel before or after a 

channel’s Trim control? Dan Gonzalez de-mystifies signal flow with answers to 

these and other question.  

 

 

 

 

  

http://blog.cakewalk.com/song-ideas-the-matrix-view/
http://blog.cakewalk.com/windows-10-for-recording/
http://blog.cakewalk.com/using-cakewalk-drum-replacer-the-right-way-and-the-other-way-2/
http://blog.cakewalk.com/transient-shaping-with-ts-64/
http://blog.cakewalk.com/know-your-signal-flow/
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